CHAPTER 13

Presentation of results
Data presentation is the procedure by which information from a GIS is presented in
a form suitable for the user. Remember that the results of a GIS analysis are used in
planning and management. Normally, data analysis is not done by the decision
makers and planners, therefore, information should be presented to them in such a
way that they are able to make sound decisions. If the information is presented to
them in a vague, unclear way, wrong decisions may be taken.
A map contains information, presented in a graphical form, intended for the map
user. A map is a means of communication, just as spoken text, video images,
graphics and sounds. A map should be well designed, so that the user can retrieve
the information quickly and easily.
Although ILWIS is not a cartographic package, it does provide the basic tools for
the creation of annotation and to convert digital spatial data (maps) to a hard copy
print.
In the first part of this chapter, an introduction is given to the use of color, both for
display on the screen and for printing. The second part of the chapter explains how
to produce an output map. The selection of colors, patterns and point symbols is
demonstrated, and the Annotation Editor is used to create a land use map. The
procedure for printing a map is shown after that, followed by the methods for
converting your data to other (cartographic) packages. The last part of this chapter
deals with the generation of demos in ILWIS.
Before you can start with the exercises, you should start up ILWIS and change to
the subdirectory c:\ilwis21\data\usrguide\chap13, where the data files for this
chapter are stored.

F
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•

Double-click the ILWIS program icon in the ILWIS program group.

•

Change the working drive and the working directory until you are in
the directory c:\ilwis21\data\usrguide\chap13.
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13.1 Introduction
When you prepare a map, you should be aware of the requirements of the map
users. A map intended for decision makers, containing clear data without details,
will be very different from one made for scientists, which should contain as much
factual information as possible.
A map may be multi-purpose, such as a topographical map, which may be used by
many different people, for different purposes. A map can also be a single-purpose
map, displaying only one theme, for example, the annual rainfall distribution.
A map has a primary content (the main theme of the map), a secondary content
(base map information, such as roads, contours, drainage), and a supportive content
(legend, scale, North arrow, location map etc.).
When you prepare a map for presentation you should decide on the scale of the map
you want to produce on paper. The scale of the output map should be based upon
considerations, such as: The purpose of the map (regional planning versus detailed
design); the requirements of the map user, the contents of the map ; the size of the
area mapped; the size of the output map (paper format); and the required accuracy.
Displaying data to be used in the final map
In ILWIS, the map making-process starts with the visualization of the mapped area
and the selection of the spatial and attribute data to be presented. You will first
have to investigate which data you want to display on your map as primary content
(main theme) and secondary content (base map information). Users should always
be able to locate themselves on a map, so each map should contain sufficient base
map information. On a large scale map this base map information can be quite
extensive, including contour lines, drainage lines, roads and other infrastructure,
and the location of villages and towns. On small scale maps, maybe only the main
roads and main towns can be displayed as base information. Putting too much base
information on a map is confusing.
It is possible to make use of one, or a combination of data layers (raster, segment,
polygon or point maps ), to compile a final output map. In the Display Options dialog boxes, which appear just before a map is displayed in a Map window, you
can specify how each map should be displayed.
The objective of the exercises in this chapter is to produce a land use map. The first
step, of the preparation process for producing an output map in this exercise, is to
display the map Landuse. Visualization of the map area is an important stage in
the preparation of the map for final printing, since further planning of the layout
can only be decided after viewing the map. For example, by visualization you are
able to check whether enough space is available for annotation or the map area has
to be extended and whether the contrast between colors representing different
mapping units is satisfactory or not.
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In this exercise the following data layers will be combined into a single map:
−

The polygon map Landuse: Forming the primary content. The map is
displayed as colored patterns.

−

The point map Labels, containing text labels of the land use polygons.

−

The raster map Shadows, containing the hillshading of the study area.

−

The segment map Contours, containing the contour lines.

−

The segment map Drainage, containing the drainage network.

−

The segment map Roads, containing the road network.

−

The point map Places, containing the location and names of the most
important locations in the area.
The various steps required, for displaying maps and adding data layers to a map
window, were explained in chapter 2.

F
•

Display the polygon map Landuse.

The map Landuse is displayed in the map window. You can add several data
layers (polygon, segment and point maps) to this Window, as long as they are using
the same coordinate system.

F
Add the other data layers mentioned above to this Map window; e.g.,
the segment maps Drainage, Roads, and Contours, the point
maps Labels and Places, and the raster map Shadows. Always
use the default parameters of the Display Option dialog boxes.
It is clear that the map would become quite difficult to read, because it will contain
too much base map information, if you used all layers as they are. Especially the
contour lines are too densely spaced. Later on, you will make a selection of the
contour lines.

F
•

ILWIS User’s Guide

Close the map window when you have finished the exercise.
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13.2 Color
One of the most important aspects in the design of presentation maps is the
selection of the most appropriate colors.
In ILWIS, the colors of objects are defined in the representation. In chapter 2 and
4 several aspects of representations were already discussed.

F
•

Click with the right mouse button on the representation Colors and
select open from the context sensitive menu. The Representation
Editor is opened.

You will see a display of 20 colors in the Representation Editor. Every color may
be seen as a combination of different amounts of the primary colors: Red, green and
blue. (see figure 13.1)

Figure 13.1: Color systems. Left: The RGB color system. Right: The IHS color system

In ILWIS, you can work with three color systems (see figure 13.1):
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−

The RGB (Red, Green, Blue) color system, which is used for display on most
computer screens.

−

The YMC (Yellow, Magenta, Cyan) color system, often used to describe the
color of an image produced by several hard copy devices.

−

The IHS (Intensity, Hue, Saturation) color system, used for image processing.
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In theory there is an infinite number of colors possible. ILWIS uses, for
contributions of each of the colors red, green and blue, the range from 0 to 255. The
value 255 refers to the full intensity of a basic color.
The notation:
(0, 0, 0)
returns black,
(255, 255, 255) returns white
(255, 0, 0)
returns red,
(0, 255, 0)
returns green,
(0, 0, 255)
returns blue
(255, 255, 0)
returns yellow
(255, 0, 255)
returns magenta
(0, 255, 255)
returns cyan

F
•

Click on the color Yellow. You can see that the three bars in the
lower part of the window change. Red will be 255, Green also and
Blue will be 0. The status line also shows the components of RGB
between brackets. In the case of yellow, that is (255,255,0).

•

Check the Red/Green/Blue components of the 15 colors.

•

Close the Representation Editor.

Besides manipulation of colors in the representation of maps, ILWIS also has the
possibility to retrieve and/or assign colors in calculations. Calculations on colors
require maps or table columns with a color, a picture domain or representations.
You can also see the color assignments of the items represented in the
representation Colors in a table.

F
•

Click with the right mouse button on the representation Colors and
select Open as Table from the context sensitive menu. The
representation is now shown as a table.

•

Double-click the column header button Color. The Column
Properties dialog box is opened. As you can see the column Color
has the domain Color.

The domain Color, is a domain in which the colors in the table are shown in the
notation (red, green, blue). You can convert the colors, stated in the domain colors,
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to the values of the three color systems explained earlier on, with a number of
statements, listed in table 13.1.
Table 13.1: Expression to convert a color domain into the individual values of the color systems
RGB, YMC and IHS
CLRRED (colorexpr)
CLRGREEN (colorexpr)
CLRBLUE (colorexpr)
CLRYELLOW (colorexpr)
CLRMAGENTA (colorexpr)
CLRCYAN (colorexpr)
CLRGREY (colorexpr)
CLRHUE (colorexpr)
CLRSAT (colorexpr)
CLRINTENS (colorexpr)

returns the red component
returns the green component
returns the blue component
returns the yellow component
returns the magenta component
returns the cyan component
returns the gray component
returns the hue component
returns the saturation component
returns the intensity component

By using one of these statements you can either convert the colors in a
representation, shown as a table, using map calculation formulas, or you can use
them on a map with a color domain or picture domain.

F
•

Close the Column Properties dialog box.

•

Type the following formulas on the command line and click OK each
time in the Column Properties dialog box:
Red=clrred(color) ↵
Green=clrgreen(color) ↵
Blue=clrblue(color) ↵
Yellow=clryellow(color) ↵
Magenta=clrmagenta(color) ↵
Cyan=clrcyan(color) ↵
Grey=clrgrey(color) ↵
Hue=clrhue(color) ↵
Sat=clrsat(color) ↵
Intens=clrintens(color) ↵

Now you can see the 20 colors of the representation, expressed in the components
of the three color systems explained earlier on. The first three columns red,
green and blue, are simply the same values as in the appropriate part of the
column color. The second group of three columns (yellow, magenta, and
cyan), show the colors in the YMC color system. Note that the calculation is made
in the following way:
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yellow = 255 - blue
magenta = 255 - green
cyan = 255 - red
Next, there is a column showing the gray tones of the colors. The gray component
is useful when you want to produce a gray tone map out of a color map.
The last three columns (Hue, Sat, Intens) show the values according to the IHS
color system: Assigning values to Hue (direction of the color in a threedimensional color cube), the Saturation (purity of the color), and the intensity
(brightness of the color). Note that the values of Hue, Saturation and Intensity
range from 0 to 240, because that is the range used as standard in Windows. For
the exact conversion formulas the user is referred to the On-Line Help (Topic:
Color Separation).

F
•

Compare the values in the columns you have just calculated with the
color cubes in figure 13.1, in order to get an idea of the three color
systems.

•

Close the table window.

Hints for appropriate use of color:
−

For large areas on a map, the saturation of a color may increase apparently. A
color which looks okay in the legend may be too dominating in the map.

−

Two rather similar colors can only be differentiated when they appear next to
each other in the map.

−

Hues in the red-yellow region are said to be "warm colors". Blue colors are said
to be "cold".

−

There are generally accepted color order scales. For example:
Most are evident: Blue water, green vegetation, yellow sand areas.
Some colors are more "powerful" and are used to indicate important features:
Red for high hazard areas.
To indicate increasing order scales, changing values are used: Dark to light.

−

It is not advisable to use more than 4 to 6 steps of the same hue.

−

To indicate increasing positive and negative values use two base colors:
Red/yellow & blue.

−

The same colors are perceived lighter on a computer screen than on a paper
map. Therefore, a so-called gamma factor is often used (see the on-line Help
for more information on gamma factor).
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13.3 Editing visual variables
A cartographer disposes of the following tools in the representation of information
in a map:
−

The basic types of spatial data, mentioned in chapter 2: points, lines and areas.

−

Volumetrical shapes: For example an impression of the relief shown with hill
shading.

−

Text, for legend information, topographical information and codes of mapping
units.

−

Symbols, related to points, but also other symbols, such as pie graphs, or bar
graphs, to display statistical information within mapping units.
For conveying relevant information of these cartographic tools, a cartographer can
use several visual variables. With visual variables, one can manipulate how these
above mentioned items will be displayed. There are seven visual variables: Position,
form, orientation, texture (variation of density of graphical elements with the same
overall gray expression), value (gray tones), size and color.
The visual variables that can be used in ILWIS depend on the map domain (class,
ID, value, picture, color), and on the type of map (point, segment, polygon and
raster).
If you make a division according to the type of maps, the following variables can be
used:
−

Point maps. Point can be displayed with different symbol types. The size, line
color, line thickness and fill color can be specified. Symbols can also be
displayed with text labels, or only as text labels. For the text labels you can
change the font, the font type (bold, italic etc.) and the font size.

−

Segment maps. Segments can be displayed in different colors and different
line widths.

−

Polygon maps. Polygons can be displayed in different colors and patterns, and
the boundary lines around polygons can be shown in different colors and
different line widths. The labels of the mapping units can be displayed as a
point map on top of the polygons.

−

Raster maps. Raster maps can be displayed using different colors and text can
be displayed in different colors.

In chapter 2 the different types of representations that are available for different
domains were discussed. To summarize, the ILWIS representation editor can be
used to edit colors, patterns and point symbols of a map:
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−

Class domains: Colors and patterns can be assigned to the classes of the
map.

−

Value domains: For maps with a value domain you can have two types of
representations:
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- Representation Gradual, using percentage values as limits. This can
be used for maps with any value domain.
- Representation Value, using actual values as limits. This can be used
only for user-defined value domains.
−

Identifier domains: Maps with a domain type ID have no user-defined
representation. They can only be displayed in 1, 7, 15, or 31 system colors.

Assigning colors to a class map
A map using a class or group domain always has a representation. Such a
representation can be edited in the Representation class editor.The colors or
patterns of all classes in the map are shown and can be changed in the editor.
This exercise shows how to change colors in the class map by editing its
Representation class.

F
•

Display the raster map Landuse.

•

From the Edit menu, select the Representation command.

•

Select the raster map Landuse.

The Representation Class Editor is opened. The buttons in the button bar of this
window can be used to see what the colors would look like in the case of a raster,
polygon, segment or point map. In the central part of this window, class names and
their colors can be viewed and in the lower part of the window the Red, Green and
Blue color scroll bars are visible. The color of the selected class can be edited by:
−

Selecting the class name, and then;

−

Changing the amount of the red, green and blue which are expressed as
integers between 0 and 255.
The exercise is planned in such a way to produce a simplified land use map with
the main land use classes, but it won’t always be the case. Note: When you change
the color of a class in a map (e.g. Polygon), the color of this class is also changed in
other maps using the same representation.

F
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•

Select the class bare rock.

•

Use the Red, Green and Blue color scroll bars in the lower part of
this dialog box to compose the correct color for this class.
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•

Move the Red (color) scroll bar to value 98.

•

Move the Green (color) scroll bar to value 98.

•

Move the Blue (color) scroll bar to value 98.

•

Select the class Agriculture (irrigated).

•

Change the colors to: Red = 0 , Green = 170 and Blue = 0.

•

Double-click on the class Forest.

The Edit Repr. Item dialog box is opened. The selected class is shown as text at
the top of the dialog box. The color list box displays a number of pre-defined colors.
If you want to define your own color, you can double-click the 'Custom' item at the
bottom of the list; then the Custom Colors dialog box appears. To define your own
custom color, you can also click the Custom Color command button; the Custom
Colors dialog box appears.

F
•

Select the color ForestGreen and click OK.

•

Double-click on the class Urban centre. The Edit Repr. Item
dialog box is opened again.

•

Click the button Custom Colors.

The standard Windows color dialog box is opened (see figure 13.2). It provides
another way to create an appropriate color for a class. The pre-defined colors are
shown in the group Basic colors. You can make a new color by dragging the
cursor in the Cursor Refiner box, and adjust the brightness in the bar next to it. You
can also enter the color as values of Hue/ Saturation/Luminousity (=Intensity), or as
Red/Green/Blue. When you are satisfied with a certain color, you can press the Add
to Custom Colors button: Pressing this button adds the new color to the selected
box in the custom colors palette.

F
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•

Select in the Color Refiner box a color which is approximately red
=195, green =35 and blue=35. Click the button Add to Custom
Colors. Click OK.

•

Now you are back in the Edit Repr. Item dialog box. Click OK. This
will bring you back to the Representation Editor.
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Figure 13.2 The standard Windows color dialog box

F
•

Select the colors for the various units as indicated in table 13.2.

•

Close the Representation Editor. Click the redraw button in the
map window to see the result. Close the map window.

Select the following colors for the various mapping units:
Table 13.2: Colors of the land use units
red
green
Agriculture
91
255
Agriculture (irrigated)
0
170
Airport
255
0
Bare rock
98
98
Bare soils
187
187
Forest
48
128
Grassland
159
255
Lake
0
146
Riverbed
182
182
Shrubs
106
126
Urban centre
194
35
Urban periphery
129
40
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blue
0
0
0
98
184
76
0
255
255
0
35
0

pattern
Horizontal
Vertical
Upwards
Solid
Solid
Solid
Solid
Solid
Solid
Solid
Diagonal
Crossing
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Assigning patterns to a class map
Besides colors, the Representation class editor contains a number of patterns
which can be used to represent areas in a polygon map.

F
•

Open the polygon map Landuse.

•

From the Edit menu select the Representation command, and select
the map Landuse.

•

Select the Polygon map button in the button bar of the
Representation Editor.

•

Double-click class Urban centre.

The Edit Repr. Item dialog box is opened. Note that there is now an extra list-box
Pattern in the lower part of the dialog box. From this check-box, you are able to
select a pattern and/or a color for the selected class.

F
•

Select the pattern Diagonal.

•

Click the OK button.

•

Repeat the steps and select the patterns as indicated in table 13.2.

•

Press the redraw button in the map window to see the result.

You can view the results when you display the polygon map Landuse.

F
•

Close the Representation editor when you have finished and close
the map window.

Note that patterns are only possible for polygon maps.
Creating labels for a class map
In the following exercise, you will learn how you can generate text-labels for the
polygons of the map landuse. This procedure requires the following steps:
Step 1: Polygon to point operation to create the point map Landuse.
Step 2: Shorten the name of the labels.
Step 3: Reclassify the point map Landuse into a point map Label.
478
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Step 4: Display the point map label together with the polygon map landuse.
Step 5: Edit the points (move and delete).

F
•

Click the polygon map Landuse with the right mouse button, and
select the Vectorize, and the Polygon to Point commands, from the
context-sensitive menu. The Polygon to Points dialog box is
opened.

•

Type the Output Point map name: Landuse. Click on Show and
OK. The point map is made and the Display Options dialog box
appears.

•

Click the check box Text.

•

Click the Font button. The Font dialog box is opened.

•

Select the Font Times New Roman, the Font Style: Regular
and the Size: 8.

•

Click OK in the Font dialog box. You are back in the Display
Options dialog box.

•

Clear the check box Symbol.

•

Click OK in the Display Options dialog box. The point map
Landuse is now displayed.

•

Drag-and-drop the polygon map Landuse in the map window. The
Display Options dialog box is opened. Select the check-box
Boundaries Only and Click OK. The boundaries of the polygons are
also displayed.

•

Maximize the map window.

It is clear that the polygon labels are not yet suitable for the final map: The names
are too long, some polygons are too small to have a label, and in other polygons the
name is actually outside the polygon. Therefore, you need to do some editing first.
The labels are shortened to only one character. This can be done by first creating a
new column in the table landuse and using this column to reclassify the point map.

F
•

Close the map window and open the table Landuse.

•

Type the following formula on the command line:
Label = left(%K,1) ↵
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This formula takes the first character of the names in the domain and stores it in
the column Label. The %K is a pre-defined variable, standing for the names in
the domain of the table.

F
•

Click OK in the Column Properties dialog box. Note that the output
domain is String.

•

Double-click the column button Label. The Column Properties
dialog box is opened.

•

Click the Create domain button. The Create domain dialog box is
opened. Click OK.

•

Close the table window.

•

Type the following expression on the command line:
Label.mpp:=PointMapAttribute(Landuse,Label);
With this expression the point map Landuse is renumbered with the
attribute Label and a point map Label is created. This is a source
map, not a dependent map (the assignment symbol := was used). This
is done because the point map will be edited later and you cannot edit
dependent maps.

•

Double-click the point map Label. The Display Options dialog box
is opened.

•

Repeat the steps explained before for the selection of text and symbol
type. Click OK. The point map Label is now displayed.

•

Add the polygon map Landuse to the map window.

•

Maximize the map window.

You can see that the labels are now much smaller and fit better in the polygons.
Some editing has still to be done, in order to remove the labels of polygons that are
too small, or that are located outside of the polygon.

F
•

From the Edit menu select the command Edit layer and choose the
point map Label. The point editor is opened.

With the point editor you can move points, delete points and create new points. The
use of the point editor was explained in chapter 3.
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F
•

Edit the point map Label, by deleting points in polygons that are
too small (most of the lakes). You can move points of which the text
falls outside of the polygon, and you can enter new points in very
large polygons.

•

When you are finished, click the Exit Editor button. Click OK in the
Display Options dialog box and close the map window.

Visual variables for segments: Color and line width
The visual variables for segment maps are somewhat limited: You can only vary the
color or the line width. For the production of the final map you will need three
segment maps: Contour, Drainage, and Roads. The first map is a value map
and the other two are class maps.

F
•

Open the representation Drainage.

•

From the Options menu select the option Segments. The
representation now shows how the lines would be shown.

•

Double-click the item Main river. The Edit Repr. Item dialog
box is opened. Note that you can select the line width. Change the
line width to 2 and the color to Blue. Change the color of the item
Drainage to Blue, and the one of the item Lake to Cyan. Leave
the line width 1 for these two.

•

When you are finished, click OK.

•

Open the segment map Drainage and look at the result.

•

Change in a similar way the representation of the segment map
Roads. Change the color of the item Main Roads to White and
the line width to 2, and change the color of the item Secondary
Roads to White.

•

Add the segment map Roads to the map window.

The segment map Contours has a class domain (Height), which also has a
value representation (Height). However, we do not want to display the contour
lines in different colors. They should be shown in gray, with different line
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thickness, differentiating the main contour lines (those every 100 meters) and the
intermediate ones (those every 50 meters).
Unfortunately the contour interval is 20 meters, so displaying contour every 50
meters is not possible. Therefore, only the 100 meter contours will be shown.

F
•

Drag-and-drop the segment map Contour to the map window. The
Display Options dialog box is opened.

•

Click the check-box Mask and type the following mask: ??00. This
will result in the display of the 100 meter contour lines only.

•

Click the option Single color and select the color Gray. Click
OK.

•

Close the map window.

Visual variables for point maps
Data such as the location of villages and towns, or data that are aggregated to
points such as total population per province, can be symbolized as points. When
you display polygon or raster maps, you can also use points as labels, indicating the
legend unit, as you have seen earlier on in this chapter. Points are visualized as
symbols, and/or as text, but they may vary in size according to the quantity they
represent. Different point symbol types are supported (circle, square, diamond, plus,
etc.).
Point data presented in a point map with a domain type class, can be symbolized by
editing the representation linked to the map. Point maps with the domain type
identifier or value are linked to a system representation; the process of symbolizing
the point data has to be done using Display Options - Points dialog box.
In this part of the exercise, point map Places with class domain is used. By
editing the representation used by this map, you are able to select symbol type, size,
color, line width and line color for the individual point in the map.

F
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•

Open map Places.

•

From the Edit menu select the command Representation and select
the point map Places. The Representation class editor is opened.

•

From the Options menu select the option Points. Now the
representation shows how points are displayed.

•

Double-click on the name Cerveceria Taquina (the local beer
brewery). The Edit Repr. Item dialog box is opened.

ILWIS User’s Guide

Presentation of results
•

Select a symbol type (Circle), symbol size (4), pen width (2),
color (yellow) and fill color (red) for this point.

•

Click OK.

•

Select the symbol representation for the other points according to
table 13.3.

•

Click the Redraw button in the map window to see the results of the
editing.

•

Exit the Editor when you have finished the exercise.

•

Close the map window.

Table 13.3: Symbol representation for the point map places

Cerveceria Taquina
Cochabamba
Laguna LargonMayu
Tiquipaya

Symbol
type
Circle
Circle
Circle
Circle

Symbol
size
6
12
4
8

Pen
width
1
2
1
2

Color
black
black
black
black

Fill
color
red
red
red
red

Summary: Editing visual variables
−

The visual variables that can be used in ILWIS, depend on the one hand on the
domain of the map (class, ID, value, picture, color), and on the other hand on
the type of map (point, segment, polygon and raster).

−

If you make a division according to the type of maps, the following variables
can be used:
Point maps. Point can be displayed with different symbol types. The size, line
color, line thickness, and fill color can be specified. Symbols can also be
displayed with text labels, or only as text labels. For the text labels you can
change the font, the font type (bold, italic etc.) and the font size.
Segment maps. Segments can be displayed in different colors and different
line widths.
Polygon maps. Polygons can be displayed in different colors and patterns, and
the boundary lines around polygons can be shown in different colors and
different line widths. The labels of the mapping units can be displayed as a
point map on top of the polygons.
Raster maps. Raster maps can be displayed using different colors and text can
be displayed in different colors.
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−

The ILWIS representation editor can be used to edit colors, patterns and point
symbols of a map, depending on the domain type:
Class domains: Colors and patterns can be assigned to the classes of the
map.
Value domains. For maps with a value domain you can have two types of
representations:
- Representation Gradual, using percentage values as limits. This can
be used for maps with any value domain.
- Representation Value, using actual values as limits. This can only be
used for user-defined value domains.
Identifier domains. Maps with a domain type ID have no user-defined
representation. They can only be displayed in 1, 7, 15, or 31 system colors.
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13.4 Map views
In the previous section you have learned how the individual data layers, that will
form part of the final map, can be best displayed. A data layer is a raster, polygon,
segment or point map, for which the user has specified display options such as
color, width, size, etc., for the display in a map window. An annotation layer is a
layer containing annotations, such as text, legend, box, North arrow, scale bar, grid
lines, graticule, bitmaps or pictures. The annotation layers will be treated in the
next exercise. In this exercise you will combine the various data layers into a single
map. The combination of data layers will be stored as a map view.
A map view contains the names of data layers and/or annotation layers to be
displayed in one map window. The display settings of the layers are also stored; so
the system knows the colors, widths etc. for the display of each layer. By opening a
map view, you do not need to select any data objects or annotation nor do you have
to specify their display options. The title that you give to a map view, is later visible
in the title bar of the map window. If you save a map view when zoomed in on a
map, the zoomed area will be displayed when opening the map view.
In this exercise the following data layers will be combined into a single map:
−

The polygon map Landuse: Forming the primary content. The map is
displayed as colored patterns.

−

The point map Labels, containing text labels of the landuse polygons.

−

The raster map Shadows, containing the hillshading of the study area.

−

The segment map Contours, containing the contour lines.

−

The segment map Drainage, containing the drainage network.

−

The segment map Roads, containing the road network.

−

The point map Places, containing the location and names of the most
important locations in the area.

F

ILWIS User’s Guide

•

Double-click the raster map Shadows. The Display Options dialog
box is opened. Click OK. The map is displayed.

•

Click with the right mouse button somewhere within the map and
select the command Layer management from the context sensitive
menu. The Layer Management dialog box is opened.

•

Click the button Add Map. The Add Map dialog box is opened.
Select the polygon map Landuse and click OK. The Display
Options dialog box is opened. Click OK. The polygon map
Landuse is added to the list of data layers.

•

Click the Add map button again and select the point map Labels.
Click OK. The Display Options dialog box is opened.

485

Presentation of results

F
•

Select the check-box Text and click on the Font button. The Font
dialog box is opened. Select the Font: Times New Roman, the
Font Style: regular, and the Size: 8. Click OK. Clear the check
box Symbol and click OK in the Display Options dialog box. The
point map Labels is added to the list of data layers.

•

Click the Add map button again and select the segment map
contour. Click OK. The Display Options dialog box is opened.
Click the check box Mask and type the following mask: ??00. Select
the option Single Color and select the color Brown. Click OK. The
map contour is now also added to the list of data layers.

•

Click the button Add Map again and select segment map Roads.
Click OK. Click OK in the Display Options dialog box. The
segment map Roads is now also added to the list.

•

Click the button Add Map again and select segment map
Drainage. Click OK. Click OK in the Display Options dialog
box. The segment map Drainage is now also added to the list.

•

Click the Add map button again and select the point map Places.
Click OK. The Display Options dialog box is opened. Select the
check-box Text and click on the Font button. The Font dialog box is
opened. Select the Font: Times New Roman, the Font Style:
Bold, and the Size: 12. Click OK. Select the Text color: Red.
Click OK in the Display options dialog box. The point map
Places is added to the list of data layers.

•

Click OK in the Layer Management dialog box. Now all added
layers are displayed in the map window.

Now you can save the map window with all data layers as they are now in a map
view.

F
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•

From the Files menu select the command Save view as...The Save
view as dialog box is opened.

•

Enter the Map view name: Landview.

•

Enter the Title: Landuse map of the Cochabamba area.

•

Click OK. The view is now saved.

•

Close the map window.

•

Open the map view Landview.
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As you can see, all the data layers that you have combined are now appearing in the
same way as you displayed them previously. The map view contains a list of the
maps that are combined as data layers, and the display options of the various maps.
Summary: Map views
−

A map view contains the names of data layers and/or annotation layers to be
displayed in one map window.

−

The display settings of the layers are also stored; so the system knows the
colors, widths etc., for the display of each layer.

−

Further more, the georeference is stored, meaning that when you save a map
view when zoomed in on a part of the map, this zoomed area will be displayed
when opening the map view later. By opening a map view later, you do not
need to select any data objects or annotation, neither do you have to specify
their display options.

−

The title that you give to a map view, is later visible in the title bar of the map
window. If you save a map view when zoomed in on a map, the zoomed area
will be displayed when opening the map view.

ILWIS User’s Guide

487

Presentation of results

13.5 Annotation
A map has a primary content (the main theme of the map), a secondary content
(base map information, such as roads, contours, drainage), and a supportive content
(legend, scale, North arrow, location map etc.). In the previous exercise you have
generated a map view (Landview) containing the primary content (Landuse
polygon map and Labels point map) and the secondary content (raster map
Shadows, segment maps Contours, Drainage and Roads, and point map
Places). In this exercise you will see how you can add supportive content using
the Annotation editor.
The Annotation editor can be used to place map elements in a map window, such
as titles, text, a legend, a north arrow, a scale-bar, grid lines and boxes. Besides
map elements, a picture or bitmap in the clipboard can be pasted into an ILWIS
Map window. For small scale maps it is also possible to add a graticule, which are
the lines that follow longitude and latitude, of a geographic projection as used by a
coordinate system. Annotation can be edited by double-clicking it or through the
Layer Management. The added annotation, together with the map, can be saved
as a map view. The final map that will be made is shown in figure 13.3.
Extending the Map window
A map window should be extended (by percentage or by coordinates), when there is
not enough space to position annotations. In this exercise the area of the map view
Landview is extended in order to create space for placing a title, a legend, grid
lines, a scale bar, a logo (bitmap) and a North arrow.

F
•

Display the map view Landview.

•

From the Options menu, select the commands Extend Window and
Extend by Percentage.

The Extend Window dialog box is opened. In this dialog box you can define how
far the map area should be extended in different directions (top, bottom, left and
right).

F
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•

Type 10 in the text box Percentage at Top.

•

Type 10 in the text box Percentage at Bottom.

•

Type 20 in the text box Percentage at Left.

•

Type 100 in the text box Percentage at Right.

•

Click OK.
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The map area is extended as you defined.

F
•

From the Files menu select the command Save view.

Figure 13.3: The land use map that will be made in this exercise

Opening the Annotation editor
The elements such as map title, legend, scale-bar, north arrow etc., can be added to
a map window using the annotation editor.

F
•
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From the Edit menu select the Annotation command.
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The Annotation Editor is opened. Annotation can be added to a map using one of
the following buttons in the Button bar of the Annotation Editor:
to add text (e.g. title)
to add a legend
to add grid lines
to add a graticule
to add a box
to add a scale bar
to add a North arrow
to add a picture or a bitmap from disk.

When you are finished with editing the annotation you can exit the Annotation
Editor with the Exit Annotation button.
to exit the Annotation Editor.
Adding a title
In general, a map has a title which gives a description of its contents. This exercise
shows how to create a title and how to position it in the map area. The map view
Landview created in the former exercise is used.

F
•

Click the Add text button in the button bar of the Annotation Editor.
The Display Options - Text dialog box is opened.

•

Type the following in the text box Text:
Land use map.
Cochabamba, Bolivia

490

•

Click the Font button. The Font dialog box is opened. Select the
Font: Times New Roman, the Font Style: bold, and the Size:
14. Click OK.

•

Click OK in the Display Options dialog box.
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If you select the option Transparent, the background color of the text area will not
be shown (only the text will appear). This is important when the text has to be
placed on the mapping units.
The text appears in the map window. The position of the text box and the size of
the box can be changed. The box size can be changed by dragging one of its
handles. You can size the text in one direction at a time or both directions at once,
depending on which handle you drag. To change the position of the text:

F
•

Select the text box.

•

Drag the box and place it at the top right of the map, separated by
some white area (see figure 13.3).

•

Save the map view before proceeding.

Creating a legend
A legend is created based on information available in the domain of a map and the
representation used by the domain. In this exercise a legend is created for the map
Landuse and this legend is added to the map view Landview. This map view is
created in the previous exercise.

F
•

Press the right mouse button inside the map window.

•

Select Add Annotation from the context-sensitive menu.

The Add Annotation dialog box is opened. It contains a list of the available
annotation types. The selected annotation type will be added to the map window.

F
•

Select Legend by clicking its option button.

•

Click OK.

The Map Layer Selection dialog box is opened. It enables you to select a layer
from which the legend will be created.
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F
•

Select the polygon map Landuse and click OK. The Legend dialog
box is opened.

•

Click on the Font button. The Font dialog box is opened. Select the
Font: Times New Roman, the Font Style: regular, and the
Size: 10. Click OK.

•

Accept the defaults by clicking the OK button. The legend which
appears in the map window is opened.

•

Select the legend box.

•

Drag the box and move it to the right side of the map (see figure
13.3). Make sure it is aligned with the title of the map. Leave some
space open below the legend, where the scale bar should still be
placed.

•

Save the map view before proceeding.

Adding grid lines
Grid lines are regularly spaced, horizontal and vertical on a map area, according to
the coordinate system linked to the map. In this exercise grid lines are added to the
map view Landview.

F
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•

From the Edit menu, select the Add Annotation command (or press
the Add Grid lines button on the button bar).

•

Choose Grid Lines from the list. The Display Options - Grid dialog
box is opened.

•

Type 5000 in the text box Grid Distance.

•

Select LightGray in the list box Color.

•

Make sure the check-boxes Draw Border, Grid Lines and
Coordinates are selected.

•

Select the option Outside map.

•

Clear the check-box Shortened coordinates.
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F
•

Click on the Font button. The Font dialog box is opened. Select the
Font: Times New Roman, the Font Style: regular, and the
Size: 10. Click OK.

•

Click OK in the Display Options- Grid dialog box.

•

Save the map view.

Adding a North arrow
A North arrow points to the North of a map, based on the coordinate system or
georeference that is used by the map. In this exercise, a North arrow is added
anyway to the map view Landview.

F
•

Click the North-arrow button in the Annotation Editor. The Display
Options - North Arrow dialog box is opened.

•

Select the option Cross.

•

Select the Line Width: 5.

•

Select the check-box Text.

•

Click on the Font button. The Font dialog box is opened. Select the
Font: Times New Roman, the Font Style: regular, and the
Size: 16. Click OK.

•

Click OK in the Display Options - North Arrow dialog box. The
North arrow is displayed in the map window.

•

Drag the arrow and position it below the title of the map (see figure
13.3).

•

Resize the North arrow and make it smaller.

•

Save the map view.

Adding a scale bar
Map scale is a ratio indicating the relationship between the distance on the map
and the distance on the ground. In ILWIS the map scale can be expressed in the
following ways:
−

Graphically in the form of a scale bar.

−

As scale indication (e.g. 1:50000).

−

As a verbal statement (e.g. One centimeter equals 10 kilometers).
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F
•

Click the Scale bar button. The Display Options - Scale Bar
dialog box is opened.

•

Click on the Font button. The Font dialog box is opened. Select the
Font: Times New Roman, the Font Style: regular, and the
Size: 10. Click OK

•

Click OK in the Display Options - Scale bar dialog box. The scale
bar is displayed in the map window.

•

Drag the scale box and position it below the legend (see figure 13.3).

•

Save the map view.

Adding an inset map
Graphic files such as Windows Meta file (pictures), specified with extension .WMF
and bitmaps, with extension .BMP, can be added to a Map window. Furthermore,
any picture or bitmap in the clipboard (copied into the clipboard from any Windows
application), can be pasted into an ILWIS Map window. In this exercise, a bitmap
with the ITC logo will be added to the map window.

F
•

Click the Add Bitmap or Picture button. The Add Bitmap or
Picture dialog box is opened.

•

Select the bitmap Itclogo2 from the list. Click OK. The Display
Options-Bitmap dialog box is opened. Click OK. The contents of the
file are displayed in the map window.

•

Click the logo and drag it to the position as in figure 13.3.

•

Save the map view.

It is also possible to paste a picture from the clipboard in the map window.

F
•

Open the map Bolivia.

•

Open the Edit menu.

•

Select the Copy command.

The Copy to Clipboard dialog box is opened. The options in this dialog box can be
used to copy the entire map, or a selected window from the map to the clipboard.
494
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F
•

Select Entire Map. Click OK.

•

Close the map Bolivia.

The map is now copied to the clipboard. You may open the clipboard viewer in the
Windows main window. To paste this picture in a map window:

F
•

Activate the map window with the map view Landview.

•

Open the Edit menu. Select the Paste command.

•

Select Bitmap from Paste As dialog box. Click OK.

The Annotation Editor is active and the map Bolivia is pasted to the window.

F
•

Drag the bitmap and position it on a suitable place to the right of the
North arrow, below the title (see figure 13.3).

•

Size the bitmap.

•

Save the map view.

Adding a box
Finally, you will add a box to the map window that encloses the entire map. Boxes
can also be used to place around an annotation (e.g. text, legend, map area, etc.),
highlight certain areas, emphasize features, etc.

F
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•

Click the Add Box button. The Display Options - Box1 dialog box
is opened.

•

Accept the defaults by clicking the OK button. A box is added to the
map.

•

Position the box on the upper left corner of the map and resize it so
that it encloses the entire map.

•

Click the Exit Annotation Editor button.

•

Click Yes to save the map view.
495

Presentation of results
•

Click the Redraw button. Now the map is finished.

•

Close the map window.

Editing map annotation
In this exercise, the map view Landview is used to show the steps on editing
annotations in an ILWIS. This map view was created in the previous exercises.

F
•

Open the map view Landview.

•

From the Edit menu select the Annotation command.

The Annotation Editor is opened. Existing annotation (text, legend, scale bar, box,
North arrow, bitmap or picture) can be edited by double-clicking it. Grid lines or
graticule can be edited using the menu (Layers, Display Options or Layer
Management) or context-sensitive menu (Layer Management).

F
•

Double-click the North-Arrow in the map. The Display Options North Arrow dialog box is opened.

•

Select Simple for the Arrow Type. Click OK.

To edit the grid lines:

F
•

Open the Layers menu. Select the Display Options command.

•

Select Grid line from the list. The Display Options - Grid lines
dialog box is opened.

•

Edit the Grid Lines as you wish. Click OK.

Existing annotation can be deleted or removed, using mouse together with the
Keyboard or the Layer Management menu command. To delete an annotation
layer:

F
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•

Select an annotation layer.

•

Press Delete on the Keyboard. Confirm the deletion.
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To hide an annotation layer:

F
•

In the Layer Management dialog box, select an annotation layer
that you wish to hide.

•

Clear the Show check box.

•

Click the OK button in the Layer Management dialog box.

•

Exit the Annotation Editor and save the map view.

•

Close the map window when you have finished the exercise.

Summary: Annotation
A map has a primary content (the main theme of the map), a secondary content
(base map information, such as roads, contours, drainage), and a supportive content
(legend, scale, North arrow, location map etc.).
You can add supportive content using the Annotation editor.
−

The ILWIS Annotation editor can be used to place map elements in a map
window and edit these later.

−

The following elements can be made:
Title: To add text (e.g. title) to the map and select a font type and color for the
created text.
Legend: To create a legend from the domain of a map and the representation
used by the domain. The number of records to appear per column in the
legend, font type, font size, font color, etc. can be specified.
North-arrow: To show the North orientation of a map from the georeference
that is used by the map window.
Scale bar: To add either a representative fraction scale (1 : 100000) or a
graphic scale (scale bar). The intervals in the scale bar, font and colors, are
user-defined.
Grid lines: To overlay the map with regular horizontal and vertical lines with
a certain spacing. Coordinates of the grid lines can be visualized inside or
outside the map area. The spacing, line width and color of grid lines is userdefined.
Graticule: To overlay the map with the lines that follow longitude and latitude
of a geographic projection, as used by a coordinate system.

−

Besides the items listed above, a picture or bitmap in the clipboard can be
pasted into an ILWIS map window.

−

The added annotation together with the map can be saved as a map view.
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13.6 Printing a map
ILWIS enables you to produce paper copies of raster and vector maps, accompanied
by annotation layers and attribute data. Paper copies can be created in black and
white or color. It is also possible to print only attribute data in the form of a table.
Before you can print, you should make sure that you have a printer connected to
your computer, and that the printer is correctly installed under Windows.

F
•

Open the map view Viewland.

•

From the File menu, select the Printer setup command. The
Windows Print setup dialog box is opened.

•

Select the printer (either the default printer or a specific printer,
depending on the type of printers you have available).

•

Select the Orientation: Landscape.

•

Select the appropriate paper size, depending on the type of printer
you have available.

•

Click OK.

•

From the File menu, select the Print command.

The Print dialog box is opened. The options in this dialog box are:
Entire Map: Select this option button to print the entire map.
Current Window: Select this option button to print only the part currently
displayed in the Map window.
Fit on Page: Select this option button to print a map on one page.
Scale: Select this option button to specify a scale at which the map should be
printed. This may result in printing the map on more than one page, depending on
the specified scale and size of the map.
Gamma Factor: This text box can be used to suggest a gamma correction factor.
The gamma correction factor is used to optimize the contrast in a print and to
match screen colors to printed colors. If you have already specified a gamma factor
in the printer setup, specify factor 1, to prevent a double correction.

F
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•

Select Entire Map.

•

Select Fit on Page and click OK.
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•

The map is now printed.

•

Repeat the steps, but now print the map at a scale of 1:50.000.

•

Close the Map window when you have finished the exercise.

Summary: Printing maps
−

ILWIS enables to produce paper copies of raster and vector maps accompanied
by annotation layers and attribute data.

−

Paper copies can be created in black and white or color.

−

It is also possible to print only attribute data in the form of a table.

−

Before you can print you should make sure that you have a printer connected to
your computer, and that the printer is correctly installed under Windows.

−

It is possible to print a map so that it fits on one page, or to print it with a
certain scale.

ILWIS User’s Guide

499

Presentation of results

13.7 Exporting maps (to cartographic software)
Although ILWIS has sufficient tools to produce simple output maps, it is advisable
to use specialized cartographic software for producing high quality output maps.
Software packages that can be used for cartographic map production have become
fairly easy to use, and cost effective, during the last decade. Some examples of such
software packages are ACE and Aldus Freehand.
In order to be able to use the data generated in ILWIS in such a package, you will
have to export it to an interchangeable file format. For raster maps, the easiest way
is to convert to either Windows Bitmap format, or TIFF format. Nearly all
software packages dealing with maps and images are able to read these file formats.
These formats have the major disadvantage, however, that the coordinate
information is not converted. The imported files will lose their coordinates. This
will lead to problems when you want to combine a converted raster map with vector
information in the cartographic software. When working with older versions of
Freehand, for example, you will need to include crosses in each map, and later
match the maps using the crosses. The latest version of Freehand, with the Map
publisher module, allows you to work with georeferenced data, as does the ACE
package. To make sure that the exported file from ILWIS doesn’t lose its
coordinates, the conversion to Erdas LAN is often used (in ACE for example), in
which the coordinates are preserved.
For vector data the most common file format is DXF, which is defined by AutoCad.
In this exercise you will practice the conversion of raster and vector data. For raster
maps, conversion is fairly simple.

F
•

From the File menu of the Main window, select the Export
command. The Export dialog box is opened.

•

Select the raster map Shadows from the list-box.

•

Select the Export Format: Tiff format .TIF

•

Type the Output map name: Shadow1

•

Click OK. The raster map Shadows is exported to TIF format.

Exporting point maps and segment maps is also quite simple.

F
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•

From the File menu of the Main window, select the Export
command. The Export dialog box is opened.

•

Select the point map Labels from the list-box.
ILWIS User’s Guide

Presentation of results
•

Select the Export Format: AutoCad.DXF

•

Type the Output map name: Label1

•

Click OK. The point map Label1 is exported to DXF format.

•

Repeat the operation for the segment map Drainage. Export it to
Drain1.DXF

For polygon maps the situation is more complex, due to topological differences
between a GIS and a cartographic system. In ILWIS there is only one segment as
boundary line between two polygons, while in most cartographic packages it is
assumed that each polygon is enclosed by boundary lines, so there are in fact two
lines forming the boundary of two polygons. During the conversion of a polygon
map to DXF format, each polygon will be made so that it is enclosed by boundary
lines.

F
•

From the File menu of the Main window, select the Export
command. The Export dialog box is opened.

•

Select the polygon map Landuse from the list-box.

•

Select the Export Format: AutoCad.DXF

•

Type the Output map name: Landuse.

•

Click OK. The polygon map Landuse is exported to DXF format.

Summary: File conversion to cartographic software
−

Although ILWIS has sufficient tools to produce simple output maps, it is
advisable to use specialized cartographic software for producing high quality
output maps.

−

Raster maps are converted to Windows bitmap or TIFF format, or to ERDAS
LAN format, when coordinate information should be preserved.

−

Vector files are mostly converted to Autocad DXF format.
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13.8 Creating demos with ILWIS
In this section, some examples are shown of how to create computer
demonstrations.
You can show ILWIS maps, a GIF image, a bitmap, play a sound or a video, etc.,
when a mapping unit in a domain Class map or an element in a domain ID map is
double-clicked. In an attribute table linked to the map, there should be a column
called Action, which should have a string domain. In this Action column, you
specify a file name of a map or table and its extension (.MPR, .MPA, .MPS, .MPP,
.TBT), or a GIF image, picture, sound or video, that you want to see/hear when
double-clicking a mapping unit, in a domain class map or an element in a domain
ID map.
Windows' File Manager should be used to associate non-ILWIS files with a
program that can open these files. Native ILWIS extensions are already associated
with ILWIS during the Setup of ILWIS. Associations can be found in the WIN.INI
file.
Make sure that:
−

An attribute table is linked to the map.

−

This attribute table has a column Action (column of domain string type).

−

You have typed in this column file names inclusive of path and extension of
the map, table, GIF image, picture, sound or video, that should be opened when
you double-click a certain mapping unit or element.

−

You used the File Manager (File menu, Associate), to associate non-ILWIS
extensions with a program that can open files with these extensions.

When you double-click in the map window and a class name or identifier is found,
the double-click action is set to Execute Action, and an attribute table is found
with a column Action, in which a filename is found that has a known association,
then that file is opened (map or table is shown, audio or video is played, etc.). If
another non-undefined value is found, nothing happens.
Demo example: Use of field-photos
In this exercise, you will learn how you can make a demo, using a number of
scanned photographs from the Cochabamba area, and a point map showing the
locations where the photos were taken, represented as red dots. When you doubleclick on a red dot, the appropriate photo is shown. The photos were obtained
through the scanning of snapshots and slides, using a simple scanner. These files
are available in TIF format (Photo1.tif to Photo9.tif). The locations where
the photos were approximately taken are stored in a point map.
The first thing that should be done is to import the TIF files.
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F
•

From the File menu of the Main window, select the Import
command. The Import dialog box is opened.

•

Select the Import format: Tag Image File Format .TIF.
The list of TIF files appears in the list box.

•

Select the file: Photo1.tif. The output format is set to Photo1.

•

Click OK. The file is converted.

•

Repeat this for the other photos.

•

Display the various photos. Close all map windows.

As you can see the last photo (Photo9) is rotated. To rotate it into the normal
position you can use the operation MirrorRotate.

F
•

Click the image Photo9 with the right mouse button and select the
commands Raster Operations and Mirror Rotate from the contextsensitive menu. The Mirror Rotate dialog box is opened.

•

Select the option Rotate 90 degrees, type as output map name:
Photo9r. Click on show and OK. The Display Options dialog box
is opened. Click OK. The image is rotated and the result is displayed.
Close the map window.

The next step is to create a map view for each photo. The advantage of a map view
is that it will be displayed without showing first a Display Options dialog box,
since the display options are already stored in the map view. Another advantage of
using map views is that you can give each map view a descriptive title, which will
be shown on the title bar.

F
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•

Open the image Photo1. Select from the file menu the Save view
as.. command. The Save View As dialog box is opened. Type the
Map view name: Photo1, and the Title: Country school in
the mountains.

•

Close the map window.

•

Repeat this for the other photos (Photo2 to Photo8, and
Photo9r), and create views with the same names. Type the
descriptions as given in table 13.4.
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Table 13.4: Description of photos used in the demo
View
photo2
photo3
photo4
photo5
photo6
photo7
photo8
photo9r

Title
Cochabamba seen from the Colina de San Sebastian
Indian village in the mountains
Llamas grazing in the mountains
Cochabamba by night
Transporting Chicha and Coca
Geologic fault
Central park of Cochabamba
Cochabamba wants to be Rio de Janeiro

Now the photos are finished. The next thing to do is to work with the file
containing the location of the photos. This is a point map, with the name photos.

F
•

Double-click the point map photos. The Display Options dialog
box is opened.

•

Press the Symbol button. The Symbol dialog box is opened. Select
the Symbol type: Simple, the Symbol: Circle, the Size: 10,
the Fill color: red, Line width: 1 and the Color: red. Click OK.

•

Select the check-box Text and press the Font button. Select the Font
type: Times new roman, the Font style: bold, and the Size:
12. Click OK. Select the Text color: red. Click OK in the Display
Options dialog box. The point map is displayed.

•

Drag-and-drop the raster map Shadows to the map window. The
Display Options dialog box is opened. Select the option light and
click OK. The hillshading map is now also displayed in the map
window.

•

Resize the map window, so that it is not too small.

•

Select from the file menu the Save view as.. command. The Save
View As dialog box is opened. Type the Map view name: photos,
and the Title: Photos from the Cochabamba area. Click
OK.

•

Close the map window.

The last thing that should be done is to create a table, linked to the point map
photos, that contains a column Action, and in which the names of the map
views of the photos are written.
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F
•

From the File menu of the Main window, select the commands,
Create and Create table. The Create table dialog box is opened.

•

Enter the Table name: photos and select the domain photos.
Click OK. The table is opened.

•

From the Columns menu in the table window, select the command
Add column. The Add column dialog box is opened.

•

Type the Column name: Action and select the domain String.
Click OK.

•

Type the names of the map views in the column Action, including
the extension. So for the first record, with the domain item Photo1,
you type Photo1.mpv in the column Action. Make sure that the
name of the last field in the column Action should read:
Photo9r.mpv. The extension .mpv stands for map view.

•

Close the table window.

•

Click the point map photos with the right mouse button and select
Properties. The Properties dialog box is opened. Make sure that the
check-box Attribute Table is selected and select the table photos.

•

Click OK.

Now all input data is ready, so you can do the actual demo.

F
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•

Open the map view Photos.

•

Click with the right mouse button somewhere within the map and
select the command Double Click Action. The Double-click action
dialog box is opened. Select the option: Execute Action. Click
OK.

•

Double-click on any of the red dots, to see the map view of the
photos. The explanation of each photo is shown in the title bar.

•

Make sure to close all map windows when you have finished the
exercise.
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Demo: Showing a flowchart
In this second exercise, you will see that you can use the same principle (doubleclicking a part of a map, which is linked to an attribute table containing an
Action column), to display maps in the form of a flowchart. As an example, we
have used a flowchart of the map making operations which were done in the first
part of this chapter. We have created a flowchart with a drawing package, in which
we inserted the various ILWIS icons.

F
•

Open the raster map Flowchar, have a look at it (double -clicking
the icons now will not have any effect).

•

Close the map window.

•

Open the georeference of this map (Flowchar).

As you can see the map Flowchar has coordinate system Unknown and the
minimum X and Y are 0, while the maximum X and Y are 640 and 480.
Besides this flowchart you need a point map, with a point at the centre of each icon
in the flowchart.

F
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•

Close the georeference Flowchar.

•

From the File menu of the Main window select the Create and
Create Point map commands. The Create Point map dialog box is
opened.

•

Enter the Map Name: Flowch. Select the coordinate system:
unknown. Type the Min X, Y: 0 and 0. Type the Max X,Y: 640
and 480.

•

Click the Create button of the domain list box. The Create domain
dialog box is opened.

•

Enter the domain name: Flowch. Select the option Identifier.
Select the Nr of items: 8, and the Prefix: map. Click OK.

•

The Domain editor is opened. Close this again. Now you are back in
the Create Point map dialog box. Click OK.

•

The Display Options dialog box is opened. Click OK.

•

The Point editor is opened.
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•

Drag and drop the raster map Flowchar to the map window. Click
OK in the Display Options dialog box.

•

The raster map Flowchar is added to the map window.

•

Now you can digitize the point in the centre of each icon. Click the
Add Points button in the button bar.

•

Click in the centre of the icon below the word Shadows, and enter
the name: map 1. Digitize points for the other icons also, and name
them map 2 to map 8.

•

Press the Exit Editor button when you have digitized all 8 points.
The Display Options dialog box is opened.

•

Click the Symbol button. The Symbol dialog box is opened.

•

Select the Symbol type: Symbol, and select the upper left symbol
from the list (it is in fact an empty space). Select the Size 20. Click
OK.

•

Click OK in the Display Options dialog box.

The points are now invisible. They are there, because when you click any of the
icons you will get the name of the point. What should be done now is to save the
map window as a view.

F
•

Select from the file menu the Save view as.. command. The Save
View As dialog box is opened. Type the Map view name:
Flowchar, and the Title: Flowchart for the production
of a land use map for the Cochabamba area. Click
OK.

•

Close the map window.

To speed up the process, and also to allow you to see how your own landuse map,
generated earlier on in this chapter, corresponds with the one that we have made,
the maps required for the flowchart are already stored as map views. The
relationship between the map views and the points that you have digitized is shown
in table 13.5.

F
•
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From the File menu of the Main window, select the commands,
Create and Create table. The Create table dialog box is opened.
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Enter the Table name: Flowch, and select the domain Flowch.
Click OK. The table is opened.

•

From the Columns menu in the table window, select the command
Add column. The Add column dialog box is opened.

•

Type the Column name: Action, and select the domain String.
Click OK.

•

Type the names of the map views in the column Action, including
the extension, as shown in table 13.5.

•

Close the table window.

•

Click the point map Flowch with the right mouse button and select
Properties. The Properties dialog box is opened. Make sure that the
check-box Attribute Table is selected, and select the table Flowch.
Click OK.

Table 13.5: The names of the map views, corresponding to the data layers for the construction of
the landuse map, and the points in the point map flowch
Point in point map flowch

Map made earlier on in this exercise

Map view name that we have
made for you

map 1

shadows

flowshad.mpv

map 2

landuse

flowlan.mpv

map 3

labels

flowlabe.mpv

map 4

contours

flowcont.mpv

map 5

drainage

flowdrai.mpv

map 6

roads

flowroad.mpv

map 7

places

flowplac.mpv

map 8

landview

viewland.mpv

Now all input data is ready, so you can do the actual demo.

F
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•

Open the map view Flowchar. Click with the right mouse button
somewhere within the map, and select the command Double Click
Action. The Double-click action dialog box is opened. Select the
option: Execute Action. Click OK.

•

Double-click on any of the icons, to see the map view of the data
layers.

•

Make sure to close all map windows when you have finished the
exercise.

ILWIS User’s Guide

Presentation of results

Creating a slide show
The last example of the preparation of a demo with ILWIS, is the creation of a slide
show, that can be used to display multi-temporal maps, in order to evaluate changes
through time. The operation Slide show is meant for this purpose.
In Slide show, a map window shows multiple raster maps like a slide show. It is in
fact the same as repeatedly replacing the raster map in a map window, e.g. by
dragging the raster maps into the map window. The raster maps to be displayed are
stored in a map list.
A map list is a data object and stores the names of a set of raster maps, for example
of the multi-spectral bands of a satellite image that you want to classify. A map list
may also store the names of several raster maps of a time series which you can
display as a slide show. All raster maps in a map list must have the same domain
and georeference.
In the slide show only one set of display options will be used. The defaults are
based on the first map in the map list. The parameters set for this map in the map
list, also define the display options for the other maps in the map list.
Slide show is, therefore, useful for multi-temporal monitoring, where data
regarding a site is collected on more than one occasion. It can, for example, be used
for observing a series of satellite images of the same area in time, derived products
such as NDVI, or classified maps, such as land use maps. In this way you get a
clear view of the general changes in time.
In this example, you will work with multi-temporal maps showing the growth of
the city of Manizales, located in central Colombia, with a set of 8 maps from 1851
till 1989. These maps are available as bitmaps. So the first step is to convert them
to ILWIS.

F
•

From the File menu of the Main window, select the Import
command. The Import dialog box is opened.

•

Select the Import format: Windows bitmap .BMP. The list of
BMP files appears in the list box.

•

Select the file: M1851.bmp. The output format is set to m1851.

•

Click OK. The file is converted.

•

Repeat this for the other maps (m1930, m1949, m1960,
m1970, m1977 and m1989).

•

Display the various maps. Close all map windows.

In order to show these maps as a slide show, you should first create a maplist,
containing the names of these maps.
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F
•

From the File menu of the Main window, select the Create and the
Create Map List commands. The Create Map List dialog box is
opened.

•

Enter the Map List Name: Manizal.

•

Enter the Description: Growth of the city of
Manizales (Colombia).

•

Select the raster maps m1851, m1930, m1949, m1960, m1970,
m1977, and m1989 (use the multiple selection option by clicking a
while keeping the Ctrl key pressed). Click OK.

Now you can run the slide show.

F
•

From the Operations menu of the Main window, select the
Visualization and the Slide show commands. The Show Map List
dialog box is opened.

•

Select the Map List Manizal and click OK.

•

The Display Options Raster map dialog box is opened, with the
display options for the first map (m1851). Click OK.

•

The Display Options Map List dialog box is opened. In this dialog
box you can change the refresh rate, indicating how many times per
minute the display will be changed. Change the refresh rate to 60.
Click OK.

Now the maps are displayed in the map window one by one, so that you can
evaluate the changes more easily. You can change the refresh rate, to make the
display more slowly or more rapidly.

F
•
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When you have finished seeing the slide show, close the map window
by double-clicking the control-menu box.
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Summary: Creating demos in ILWIS
−

You can show ILWIS maps, a GIF image, a bitmap, play a sound or a video,
etc., when a mapping unit in a domain class map or an element in a domain ID
map is double-clicked.

−

In an attribute table linked to the map, there should be a column called
Action, which should have a string domain. In this Action column, you
specify a file name of a map or table and its extension (.MPR, .MPA, .MPS,
.MPP, .TBT), or a GIF image, picture, sound or video, that you want to
see/hear when double-clicking a mapping unit in a domain class map, or an
element in a domain ID map.

−

Another way of using demos with ILWIS is the creation of a slide show, that
can be used to display multi-temporal maps, in order to evaluate changes
through time. The operation Slide show is meant for this purpose.

−

In Slide show a map window shows multiple raster maps like a slide show. It
is in fact the same as repeatedly replacing the raster map in a map window,
e.g. by dragging the raster maps into the map window. The raster maps to be
displayed are stored in a map list.
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